SAFETY INSTRUCTIONS

NOTICE FOR CUSTOMERS IF YOUR UNIT IS EQUIPPED WITH A POWER CORD.

WARNING: THIS APPLIANCE MUST BE EARTHEd.

The cores in the mains lead are coloured in accordance with the following code:

GREEN - Earth
YELLOW - Neutral
BLUE - Live
BROWN - Live

As colours of the cores in the mains lead of this appliance may not correspond with the coloured markings identifying the terminals in your plug, proceed as follows:

• The core which is coloured green and yellow must be connected to the terminal in the plug marked with the letter E, or with the earth symbol, or coloured green or green and yellow.
• The core which is coloured blue must be connected to the terminal marked N or coloured black.
• The core which is coloured brown must be connected to the terminal marked L or coloured red.

This equipment may require the use of a different line cord, attachment plug, or both, depending on the available power source at installation. If the attachment plug needs to be changed, refer servicing to qualified service personnel who should refer to the table below. The green/yellow wire shall be connected directly to the units chassis.

<table>
<thead>
<tr>
<th>CONDUCTOR</th>
<th>WIRE COLOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>LIVE</td>
</tr>
<tr>
<td>N</td>
<td>NEUTRAL</td>
</tr>
<tr>
<td>E</td>
<td>EARTH GND</td>
</tr>
<tr>
<td></td>
<td>NORMAL</td>
</tr>
<tr>
<td></td>
<td>ALT</td>
</tr>
<tr>
<td></td>
<td>BROWN</td>
</tr>
<tr>
<td></td>
<td>BLACK</td>
</tr>
<tr>
<td></td>
<td>BLUE</td>
</tr>
<tr>
<td></td>
<td>WHITE</td>
</tr>
<tr>
<td></td>
<td>GREEN/YEL</td>
</tr>
<tr>
<td></td>
<td>GREEN</td>
</tr>
</tbody>
</table>

WARNING: If the ground is defeated, certain fault conditions in the unit or in the system to which it is connected can result in full line voltage between chassis and earth ground. Severe injury or death can then result if the chassis and earth ground are touched simultaneously.

POWER ON/OFF SWITCH: For products provided with a power switch, the power switch DOES NOT break the connection from the mains.

MAINS DISCONNECT: The plug shall remain readily operable. For rack-mount or installation where plug is not accessible, an all-pole mains switch with a contact separation of at least 3 mm in each pole shall be incorporated into the electrical installation of the rack or building.

FOR UNITS EQUIPPED WITH EXTERNALLY ACCESSIBLE FUSE RECEPTACLE: Replace fuse with same type and rating only.

MULTIPLE-INPUT VOLTAGE: This equipment may require the use of a different line cord, attachment plug, or both, depending on the available power source at installation. Connect this equipment only to the power source indicated on the equipment rear panel. To reduce the risk of fire or electric shock, refer servicing to qualified service personnel or equivalent.

This Equipment is intended for rack mount use only.
LITHIUM BATTERY WARNING

CAUTION!
This product may contain a lithium battery. There is danger of explosion if the battery is incorrectly replaced. Replace only with an Eveready CR 2032 or equivalent. Make sure the battery is installed with the correct polarity. Discard used batteries according to manufacturer's instructions.

ADVAREL!

ADVAREL!
Lithiumbatteri - Eksplosjonsfare ved feilagtig håndtering. Udskiftning må kun ske med batteri av samme fabrikat og type. Levør det brugte batteri tilbage til leverandøren.

VAROITUS!

WARNING!

U.K. MAINS PLUG WARNING
A molded mains plug that has been cut off from the cord is unsafe. Discard the mains plug at a suitable disposal facility. NEVER UNDER ANY CIRCUMSTANCES SHOULD YOU INSERT A DAMAGED OR CUT MAINS PLUG INTO A 13 AMP POWER SOCKET. Do not use the mains plug without the fuse cover in place. Replacement fuse covers can be obtained from your local retailer. Replacement fuses are 13 amp and MUST be ASTA approved to BS1362.

DECLARATION OF CONFORMITY

Manufacturer's Name: DigiTech
Manufacturer's Address: 8760 S. Sandy Parkway
Sandy, Utah 84070, USA

declares that the product:

Product name: JamMan Looper
Product option: all (requires Class II power adapter that conforms to the requirements of EN60065, EN60742, or equivalent.)

conforms to the following Product Specifications:

EMC: EN 55013 (2001+A1)
EN 55020 (1998)

Supplementary Information:


Vice-President of Engineering-MI
8760 S. Sandy Parkway
Sandy, Utah 84070, USA
Date: June 17, 2005

European Contact:
Your local DigiTech Sales and Service Office or

Harman Music Group
8760 South Sandy Parkway
Sandy, Utah
84070 USA
Ph: (801) 566-8000
Fax: (801) 566-7583

ELECTROMAGNETIC COMPATIBILITY

This unit conforms to the Product Specifications noted on the Declaration of Conformity. Operation is subject to the following two conditions:

- this device may not cause harmful interference, and
- this device must accept any interference received, including interference that may cause undesired operation.

Operation of this unit within significant electromagnetic fields should be avoided.

- use only shielded interconnecting cables.
We at DigiTech® are very proud of our products and back up each one we sell with the following warranty:

1. The warranty registration card must be mailed within ten days after purchase date to validate this warranty, or you can register via our website (www.digitech.com).

2. DigiTech warrants this product, when used solely within the U.S., to be free from defects in materials and workmanship under normal use and service.

3. DigiTech liability under this warranty is limited to repairing or replacing defective materials that show evidence of defect, provided the product is returned to DigiTech WITH RETURN AUTHORIZATION, where all parts and labor will be covered up to a period of one year (this warranty is extended to a period of six years when the product has been properly registered by mail or through our website). A Return Authorization number may be obtained from DigiTech by telephone. The company shall not be liable for any consequential damage as a result of the product’s use in any circuit or assembly.

4. Proof-of-purchase is considered to be the burden of the consumer.

5. DigiTech reserves the right to make changes in design, or make additions to, or improvements upon this product without incurring any obligation to install the same on products previously manufactured.

6. The consumer forfeits the benefits of this warranty if the product’s main assembly is opened and tampered with by anyone other than a certified DigiTech technician or, if the product is used with AC voltages outside of the range suggested by the manufacturer.

7. The foregoing is in lieu of all other warranties, expressed or implied, and DigiTech neither assumes nor authorizes any person to assume any obligation or liability in connection with the sale of this product. In no event shall DigiTech or its dealers be liable for special or consequential damages or from any delay in the performance of this warranty due to causes beyond their control.

NOTE: The information contained in this manual is subject to change at any time without notification. Some information contained in this manual may also be inaccurate due to undocumented changes in the product or operating system since this version of the manual was completed. The information contained in this version of the owner’s manual supersedes all previous versions.
Table of Contents

Thank You ..............................................................................................................................................3
Quick Start ..................................................................................................................................................4
Guided Tour - Front Panel ..........................................................................................................................8
Guided Tour - Rear Panel ..........................................................................................................................12
Making Connections ..................................................................................................................................14
Recording an Instrument or Vocal/Acoustic Phrase ..............................................................................16
Recording with the Aux Input ..................................................................................................................17
Recording Overdubs ..................................................................................................................................19
Undo, Redo, and Clear ...............................................................................................................................21
  Undo an Overdub ........................................................................................................................................21
  Redo an Overdub .......................................................................................................................................21
  Clear Overdubs/Unsaved Phrases ...........................................................................................................21
Storing/Copying Phrases ............................................................................................................................22
  Store Changes to a Loop .........................................................................................................................22
  Copy a Loop to a Different Memory Location .......................................................................................22
Setting a Loop Tempo for Recording ....................................................................................................23
Auto Record Mode .....................................................................................................................................24
Stop Modes ................................................................................................................................................25
Changing Loop Tempo .............................................................................................................................26
Loop / Single Phrases ................................................................................................................................27
Time Signature ............................................................................................................................................28
Rhythm Type ..............................................................................................................................................29
USB File Transfer ....................................................................................................................................30
  Exchange Files Between Your Computer and the JamMan® ...............................................................30
Deleting Phrases .......................................................................................................................................32
Erasing All Loops / Formatting the CompactFlash® Card ......................................................................33
  Erase Loops .............................................................................................................................................33
  Format a CompactFlash Card ................................................................................................................33
  Unformatted Cards ...............................................................................................................................34
Optional FS3X Footswitch ..........................................................................................................................35
Multiple Loop Playback Using the FS3X ...................................................................................................36
CompactFlash Capacity .............................................................................................................................37
Specifications .............................................................................................................................................38
Congratulations and special thanks from DigiTech® for choosing the DigiTech JamMan® Looper/Phrase Sampler.

The DigiTech JamMan Looper/Phrase Sampler is designed for the performing vocalist and musician. By using CompactFlash™ memory, the JamMan is capable of creating seamless loops with virtually infinite overdub capability. Input audio can be from an instrument, microphone or line level audio source. Up to 99 loops can be stored on a CompactFlash card (.wav format) which can be transferred to a PC for archiving. An optional three-button footswitch can be connected for remote loop access and auto-record functions. Record your own loops and overdub them on the fly, in the studio, or onstage.

And when using an optional 2GB CompactFlash card, you can record hours of loops and samples, instead of just minutes. Connect to a computer via the JamMan’s USB port and transfer loops to your hard drive. Load up the JamMan with a drum track, bass line, vocal and solo harmonies . . . it becomes a band in a box. Slow down or speed up any song without changing pitch. With the DigiTech JamMan in your bag of tricks, the possibilities are literally endless.

**Included Items**
- JamMan
- CompactFlash card (128 MB)
- Power Supply
- This Manual
- Registration Card
Before powering up your JamMan®:

**a. Make Connections**
1. Connect a guitar or bass to the **INSTRUMENT INPUT** jack and/or a mic to **MIC INPUT** on the JamMan’s rear panel.
2. Connect the JamMan’s **OUTPUT** to the input of an amplifier, a channel of a mixer, or to headphones.

**b. Connect the Power Supply**
1. Start with your amplifier and the JamMan turned off or the mixer faders at their minimum position.
2. Turn the **LOOP LEVEL**, **RHYTHM LEVEL**, **MIC LEVEL**, and **INST LEVEL** knobs all the way down on the JamMan.
3. Connect the PS-0913B power supply to the **POWER** jack on the JamMan.
4. Connect the other end of the PS-0913B power supply to an AC outlet.
5. Turn your amplifier on and turn up its volume to a normal playing level or bring up the mixer’s faders to a nominal level.

**c. Insert the CompactFlash® Card**
Insert the included CompactFlash® card into the CompactFlash card slot (if it isn’t already inserted).
2. Select an Empty Loop
Rotate the **SELECT** knob until the **LOOP** LED and the **SINGLE** LED are off.

3. Select the Record Mode
Press the **RECORD MODE** button repeatedly until the **INST/MIC** LED lights.
Quick Start

4. Adjust the Recording Level
Play your guitar (or sing into the mic) at the level you will be recording. Adjust the INST LEVEL (or MIC LEVEL) knob until the PEAK LED occasionally flickers on the loudest notes. Set the loop level and rhythm level knobs to the 9 o’clock position.

5. Start Recording
Press the REC/PLAY/OVERDUB (left) footswitch to start recording. While recording, the RECORD LED remains lit.
6. Stop Recording, Start Playback
Press the **REC/PLAY/OVERDUB** (left) footswitch while recording to stop recording and start playing back from the beginning. The **PLAY** LED lights. Adjust the **LOOP LEVEL** and **RHYTHM LEVEL** knobs as needed.

![Diagram of pedal with labels for REC/PLAY/OVERDUB, LOOP LEVEL, RHYTHM LEVEL, and PLAY LED]

7. Stop Playback/Store the Loop
Press the **STOP/TEMPO** (right) footswitch to stop playback, then press the **STORE** button twice to store the loop.

![Diagram of pedal with labels for STOP/TEMPO, STORE button, and instructions for stopping playback and storing the loop]
1. **Loop Level Knob**  
   Controls playback level of recorded loops.

2. **Rhythm Level Knob**  
   Controls the level of the rhythm guide track.

3. **Loop/Single/Card Busy LEDs**
   
   **LOOP**  
   Lights when a repeating Loop resides in the selected memory location.
Guided Tour - Front Panel

**SINGLE**
Lights when a Single playback phrase resides in the selected memory location.

**CARD BUSY**
Lights when there is read/write activity on the CompactFlash® card. The card should not be removed when the CARD BUSY LED is lit.

4. **Display**
Displays which loop memory location is selected. It also shows information during store/copy procedures, during Time Signature and Rhythm Type setup, USB connection, and file deletion/card formatting procedures.

5. **Select Knob**
Used for selecting different loops on the CompactFlash card and making selections when in other modes (such as Time Signature and Rhythm Type).

6. **Mic Level Knob**
Controls the input signal from the XLR MIC INPUT jack.

7. **Peak LED**
Lights when the Instrument, Mic, or Aux Input signals are too loud. Adjust the INST LEVEL or MIC LEVEL knobs so this LED lights only occasionally. If the AUX INPUT is being used, adjust the output level of the audio source.

8. **Inst Level Knob**
Controls the input signal from the 1/4” INST. INPUT jack.

9. **Record Mode/Stop Mode LEDs**
Indicate which Record Mode or Stop Mode is selected.
10. Record Mode (Stop Mode) Button
Press this button to select the inputs that are to be recorded: Inst/Mic or Aux Input with options of Minus Center and/or Full Range Amp (indicated by the LEDs next to the button).

Press this button while the \textbf{SHIFT} button is lit to select one of two Stop Modes: Stop or Finish (indicated by the LEDs next to the button). For more information about Stop Modes, see page 25.

11. Auto Record (Delete) Button
Press this button to enable Auto Record. When Auto Record is enabled, recording begins automatically when you begin your performance.

Press this button while the \textbf{SHIFT} button is lit to delete the contents of the current memory location. For more information about the Delete function, see page 32.

12. Tempo (Time Signature) Button
Press this button to set or change the loop tempo. If tempo for an existing loop is changed, the loop plays back at the new tempo without any change of pitch. See pages 23 and 26 for more information about Tempo.

Press this button while the \textbf{SHIFT} button is lit to change the Time Signature. For more information about Time Signatures, see page 28.

\textbf{NOTE}: Time Signature can only be changed for a memory location that has no phrase recorded in it.

13. Stop/Tempo Footswitch
Stops recording, playback and overdubbing of the phrase. It can be used like the \textbf{TEMPO} button (#12) to set the tempo before recording a loop. Press and hold this footswitch for two seconds to clear all unstored audio in a loop.
14. Rec/Play/Overdub Footswitch
   Starts and toggles between recording, playback and overdubbing. Press and hold this footswitch for two seconds to undo the last overdub.

15. Loop/Single (Rhythm Type) Button
   Changes the playback status of a recorded phrase. When LOOP is lit the phrase will play back in an endless loop. When SINGLE is lit, the phrase will play once and stop.

   Press this button while the SHIFT button is lit to change the Rhythm Type. Turn the SELECT knob to change the active rhythm guide track. You can hear the changes as you make them if Rhythm Level is turned up. See page 29 for more information about Rhythm Type.

16. Store Button
   Press to store/copy changes made to a memory location. This button will light when a change has been made indicating the change must be stored for later recall. Changes that are not stored will be lost when a different loop is selected or the JamMan® is turned off.

17. Exit (Shift) Button
   Press to enter and exit Shift Mode to select secondary button functions. Shift Mode is active when this button is lit.

18. Record/Play/Overdub LEDs
   RECORD - Lights when recording to a memory location for the first time.
   PLAY - Lights when playing back a recorded loop or single phrase.
   OVERDUB - Lights when overdubbing to an existing loop.
1. **1/4” Inst Input Jack**
   Connect a guitar, bass, or keyboard output here.

2. **XLR Mic Input Jack**
   Plug your microphone in here. Accepts low impedance dynamic or self powered condenser microphones.

3. **1/8” Aux Input Jack**
   Plug your CD or other music playback source in here. (Any stereo source is summed to mono when recorded.)

4. **1/4” Output Jack**
   Connect this output to the input of a guitar amplifier, a channel of a mixer, or headphones.
5. **1/4” Footswitch Jack**
Plug the optional FS3X Footswitch in here. (FS3X functions control next/previous loop selection and Auto Record on/off.) See pages 35 and 36 for more information about the FS3X Footswitch.

6. **CompactFlash® Card Slot**
The JamMan is compatible with Type I CompactFlash® cards up to 2GB in size. Type II cards and IBM/Hitachi Microdrives™ are not supported. New cards may need to be formatted before use (see page 33 for formatting instructions). **Important**: Never remove the CompactFlash card during recording, playback, overdub, or when the **CARD BUSY** LED is lit.

**NOTE**: When the JamMan is shipped from the factory, the CompactFlash card is held in place with a security bracket. To remove the security bracket, unscrew and remove the **FOOTSWITCH** input nut with a 12mm nut driver. After removing the security bracket, replace the nut on the **FOOTSWITCH** input.

7. **USB Connection**
Plug a USB cable connected to your computer in here for loop transfer to and from the CompactFlash card.

8. **Power Supply Jack**
Plug only the PS-0913B power supply in here.
Making Connections

Instrument and Microphone
Connect a guitar, bass, or keyboard to the **INSTRUMENT INPUT** jack, or plug a microphone into the **MIC INPUT** jack.

CD/MP3 Player
You can connect an external line level audio source such as a CD or MP3 player to the **AUX INPUT** jack and record loops and samples from the external audio source. See page 17 to learn how to use the Aux Input Record Mode.

Amplifier/Mixer
Connect an amplifier, mixer, or headphones to the **1/4” OUTPUT** jack.
DigiTech® FS3X Footswitch (Optional)
Connect the optional FS3X Footswitch to the 1/4” FOOTSWITCH jack using a TRS stereo cable. The FS3X provides hands-free loop selection and enables the Auto Record feature.

CompactFlash® Card
Insert a formatted Type I CompactFlash® card here (to learn how to format a CompactFlash card, see page 33). Most CompactFlash cards (except Microdrives) are Type I. The JamMan® is compatible with Type I cards only, up to 2GB in size. Important: Never remove the CompactFlash card during recording, playback, overdub, or when the CARD BUSY LED is lit.

Computer
Plug in a standard USB cable here and connect it to your computer for loop transfer to and from the CompactFlash card.

Power Supply
Plug the JamMan into a power source using the supplied power supply (PS-0913B).
The JamMan® is very simple to use once you set it up for your particular use. This section explains how to record an instrument or vocal/acoustic phrase and play it back as a continuous loop. You should have a guitar/instrument and/or a mic connected before proceeding.

1. Select an empty memory location using the SELECT knob (the LOOP and SINGLE LEDs will be off).
2. Select INST/MIC as the recording mode using the RECORD MODE button.
3. Play or sing and adjust the INST LEVEL or MIC LEVEL knob so that the PEAK LED lights only occasionally.
4. (Optional) If you would like to perform to a click track, you must first set a tempo. The rhythm guide track will not be heard until a tempo has been set. You can set a tempo by tapping the STOP/TEMPO footswitch or TEMPO button at the tempo you want to play (see page 23). Adjust the RHYTHM LEVEL knob to a suitable volume.
5. (Optional) Set the Time Signature to something other than 4/4, if desired. (See page 28 for more information about Time Signatures.)
6. (Optional) Turn the AUTO REC button on if you want the JamMan® to begin recording when you start playing.
7. Press the REC/PLAY/OVERDUB footswitch to start recording. If a tempo has been set, the RECORD LED will flash and there will be a single measure count-in before recording begins. The RECORD LED will then light solid and recording will start. If no tempo has been set, recording will begin instantly after the REC/PLAY/OVERDUB footswitch is pressed. If Auto Record is enabled, the RECORD LED will flash after the footswitch is pressed indicating it is armed for recording. Recording will automatically begin once you start playing.
8. When you are finished, press either the REC/PLAY/OVERDUB footswitch to have the phrase play back in a repeating loop or press the STOP/TEMPO footswitch to stop recording.

**NOTE:** The minimum loop length is 3.5 seconds.

Once you are finished recording, the STORE button will be lit indicating the phrase must be stored to memory to be recalled later (See the Storing/Copying Phrases section on page 22). When stored, the LOOP LED will light indicating there is now a phrase stored to the memory location.
This section explains how to use the **AUX INPUT** for phrase recording and looping. You should have an audio source connected to the **AUX INPUT** before proceeding.

1. Select an empty memory location using the **SELECT** knob (the **LOOP** and **SINGLE** LEDs will be off).
2. Press the **RECORD MODE** button repeatedly to cycle through the available Record Modes. Choose one that lights the **AUX INPUT** LED. There are four possible recording modes for the **AUX INPUT**:
   a. **AUX INPUT** only lit: The unit will record the program material just as it comes from the source (any stereo material will be mixed to mono).
   b. **AUX INPUT** and **CENTER CANCEL** lit: Any material that is common to both stereo channels (usually lead vocals or instruments) will be removed from the recording. Any stereo processing of the center channel (reverb, for instance) might not be removed completely.
   c. **AUX INPUT** and **FULL RANGE SIM** lit: The program material will be recorded with an equalization curve so that when it is played through a guitar amp it will more closely retain its original frequency response.
   d. **AUX INPUT** and **CENTER CANCEL** and **FULL RANGE SIM** lit: This will remove center channel material and apply a compensating equalization as in the two previous modes.
3. Playback the audio source and set its output level so that the **PEAK** LED lights only occasionally.
4. (Optional) Set the Time Signature to something other than 4/4, if desired. (See page 28 for more information about Time Signatures.)
5. (Optional) Turn the **AUTO REC** button on if you want the JamMan® to begin recording when the audio source begins playback.
6. Press the **REC/PLAY/OVERDUB** footswitch to start recording. The **RECORD** LED will then light solid and recording will begin instantly after the **REC/PLAY/OVERDUB** footswitch is pressed. If Auto Record is enabled, the **RECORD** LED will flash after the footswitch is pressed indicating it is armed for recording. Recording will automatically begin once the audio source starts playing.
7. When you are finished, press either the REC/PLAY/OVERDUB footswitch to have the phrase play back in a repeating loop or press the STOP/TEMPO footswitch to stop recording.

**NOTE:** The minimum loop length is 3.5 seconds.

Once you are finished recording, the STORE button will be lit indicating the phrase must be stored to memory to be recalled later (see the Storing/Copying Phrases section on page 22). When stored, the LOOP LED will light indicating there is now a phrase stored to the memory location.
Recording Overdubs

Once a loop phrase is recorded, you can add overdubs over the top of it. Overdubs can only be recorded to Loop phrases and not to Single phrases. If a phrase has had the tempo changed, it must first be stored to memory before overdub recording can proceed.

1. Select a previously recorded Loop phrase, or use a newly recorded phrase that has not yet been stored. The LOOP LED must be lit if a previously recorded phrase is selected.
2. Select the inputs you want to record using the RECORD MODE button.
3. Play or sing and adjust the INST LEVEL and MIC LEVEL knobs so that the PEAK LED lights only occasionally if using the INSTRUMENT or MIC inputs. If using the AUX inputs, adjust the output level of the audio source so that the PEAK LED lights only occasionally.
4. Press the REC/PLAY/OVERDUB footswitch. The PLAY LED will light and the phrase will begin playing.
5. Press and release the REC/PLAY/OVERDUB footswitch again to begin overdub recording. The OVERDUB LED will now light and any performance or audio introduced on the selected input will now be recorded along with the playback.
6. When you have an overdub you are happy with, press the REC/PLAY/OVERDUB footswitch to end the overdub session and continue playback, or press the STOP/TEMPO footswitch. If you want to undo the last overdub, press and hold the REC/PLAY/OVERDUB footswitch for two seconds. This will remove the last overdub take that was recorded. Pressing and holding the footswitch again will redo the last overdub.

**NOTE:** The Undo feature only works on the last overdub. (For more information on Undo and Redo, see page 21.)

7. You can continue adding overdubs by continuing to press the REC/PLAY/OVERDUB footswitch. Each time an overdub is added, the last overdub is merged with the original loop and it can no longer be undone using the Undo feature.
8. Once you are finished, press the STOP/TEMPO footswitch to stop playback/overdubbing.

**NOTE:** The minimum loop length is 3.5 seconds.
Recording Overdubs

The **STORE** button lights as soon as any changes to the loop have been made, indicating the phrase must be stored to memory to be recalled later (see the **Storing/Copying Phrases** section on page 22). If you don’t want to store the overdubs, press and hold the **STOP/TEMPO** footswitch for two seconds to clear any unstored audio and leave the original loop intact. Selecting another loop will also clear any unsaved overdubs from memory. Once overdubs are stored to memory, the undo and clear functions are no longer available.
Undo, Redo, and Clear

You can undo your last overdub anytime the current loop number selection remains unchanged. If you change your mind after undoing something, you can redo it.

**NOTE:** Changing loops or plugging into a computer via USB discards any unstored changes. Storing the changes will remove the ability to undo or clear overdubs.

**Undo an Overdub**
Press and hold the **REC/PLAY/OVERDUB** footswitch for two seconds to undo your last overdub. The **OVERDUB** LED flashes when the undo takes place.

**Redo an Overdub**
Press and hold the **REC/PLAY/OVERDUB** footswitch to redo the last undo; the **OVERDUB** LED flashes to indicate the action has been performed.

**Clear Overdubs/Unsaved Phrases**
Press and hold the **STOP/TEMPO** footswitch for two seconds to clear the unstored recording/overdubs. The **RECORD** LED will flash to confirm the clearing. If the loop had been previously stored, the clear action will only clear unsaved phrases and overdubs but leave the original loop that had been stored untouched.

Changing to a different loop also clears any unsaved phrases and overdubs.
Anytime a change is made to a loop memory location (Rhythm Type, Tempo, Time Signature, Record, Overdubs etc.) the **STORE** button LED will immediately light indicating that the changes will be lost unless a store procedure is performed before selecting a new loop memory location, turning off the power, or connecting to the computer via USB.

**Store Changes to a Loop**
1. Stop any playback or recording activity using the **STOP/TEMPO** footswitch.
2. Press the **STORE** button. The **STORE** button and the **DISPLAY** will begin to flash (the **DISPLAY** shows the current loop memory location).
3. (Optional) Turn the **SELECT** knob to select an empty loop memory location to store the loop with its changes (the **LOOP** or **SINGLE** LEDs are off), or press **EXIT** to abort.
4. Press the **STORE** button again. The changes are now saved and the **STORE** button turns off.

**NOTE:** Loops whose tempo has been sped up or slowed down take longer to store than normal loops.

**Copy a Loop to a Different Memory Location**
1. Stop any playback or record activity using the **STOP/TEMPO** footswitch.
2. Select a memory location that contains a loop (either the **LOOP** or **SINGLE** LED is lit).
3. Press the **STORE** button. The **DISPLAY** and the **STORE** button LED flash.
4. Turn the **SELECT** knob until an empty memory location is selected (the **LOOP** and **SINGLE** LEDs are off), or press **EXIT** to abort.
5. Press the **STORE** button again. The loop is now copied to the new memory location.

**NOTE:** The Clear and Overdub Undo/Redo functions cannot be performed after a Store/Copy procedure.
Setting a Loop Tempo for Recording

Before you begin recording a phrase, you may want to set a tempo at which you want to record the loop at. Setting the tempo in an empty loop memory location automatically starts playing the rhythm guide track (Rhythm Level must be turned up to hear it). You can use the rhythm guide track as a metronome for recording against to help keep a consistent tempo of your performance. To set the tempo for recording, follow these steps:

1. Select an empty loop memory location (LOOP and SINGLE LEDs are off).
2. Tap the TEMPO button or STOP/TEMPO footswitch at least twice. The TEMPO button will flash at the tempo that has been tapped.
3. Turn up the RHYTHM LEVEL (if it hasn’t been already) to hear the rhythm guide track.
4. Begin recording by pressing the REC/PLAY/OVERDUB footswitch.

If you want to set up a memory location with a tempo but not record to it, you can just follow steps 1-3, but you must store the newly set tempo using the Store procedure (see page 22). When you return to the empty loop location, the tempo will already be set and the rhythm guide track will begin playing automatically.
Auto Record Mode

The AUTO REC (auto record) button starts recording when you start playing. Press this button on an empty track (you can’t auto-record on an existing track) and the button lights. Now when you press the REC/PLAY/OVERDUB footswitch, the JamMan® is armed for recording but won’t start recording until you start playing (the RECORD LED will flash to show that the JamMan is armed). The JamMan monitors the input level and starts the recording when it detects an audio signal.

If you’ve tapped in a tempo, the rhythm guide track playback will restart at the beginning of recording. If not, the rhythm guide track playback will begin when you finish recording and begin loop playback. Once recording starts, the AUTO REC LED will turn off.

Changing the loop number while AUTO REC is active will preserve the AUTO REC state on empty loops (the LED will turn off when an existing loop is selected).

To turn off Auto Record, press the AUTO REC button until its LED is off.
Stop Modes

Loop Phrases can be stopped in two ways: Immediately stop when the STOP/TEMPO footswitch is pressed or finish playing through to the end of the phrase and stop. These two Stop Modes are called Stop and Finish. To change Stop Modes, follow these steps:

1. Press the **SHIFT** button. It will now be lit.
2. Press the **RECORD MODE** button. The two Stop Modes are labeled to the right of the **RECORD MODE** LEDs. Select the LED which is labeled with the Stop Mode you want to use.
3. Press the **EXIT** button.
4. Press the **STORE** button twice to store the changes, if desired.
Changing Loop Tempo

Once a loop phrase is recorded, you can speed up or slow down the playback of the phrase without changing its pitch. Once a phrase has had the tempo changed, it must first be stored to memory before any overdubs can be added. Storing a changed tempo is permanent and the original tempo cannot be restored. To change a loop’s tempo, follow these steps:

1. Select a previously recorded Loop phrase (LOOP or SINGLE LED is lit) using the SELECT knob. The TEMPO button will begin flashing at the phrase’s stored tempo.
2. To change the phrase tempo, tap either the TEMPO button or the STOP/TEMPO footswitch while the loop is stopped (or just the TEMPO button while the loop is playing) at the rate you want playback to continue. Tapping quicker than the stored tempo rate will speed up playback while tapping slower than the stored tempo rate will slow down playback.
3. To return to the original tempo, press and hold the TEMPO button for two seconds and the phrase will return to the original stored tempo.
4. The STORE button will light to indicate this change must be stored if it is to be recalled later.
5. Press the STORE button twice to store the changes, if desired.

You can play along with the adjusted playback speed and still be in tune since the pitch does not change based on playback speed. Overdubs can only be added after the new tempo is stored to memory first.

NOTE: Loops whose tempo has been sped up or slowed down take longer to store than normal loops.
Any phrase recorded into the JamMan® can be played in two ways: either as a continuous Loop, or as a Single “one-shot” sample. Single phrases are designed to play through only once and stop. All phrases are recorded as loops first but they can be changed to a Single if desired and can always be changed back to Loops later without harming the phrase. To change between Single and Loop, follow these steps:

1. Select a previously recorded Loop phrase (LOOP LED is lit) using the SELECT knob.
2. Press the LOOP/SINGLE button. The LOOP LED will turn off and the SINGLE LED will now turn on indicating the phrase will now play back once when the REC/PLAY/OVERDUB footswitch is pressed.
3. The STORE button will light to indicate this change must be stored if it is to be recalled later.
4. Press the STORE button twice to store the changes, if desired.

Single phrases cannot have overdubs added to them. Repeated presses of the REC/PLAY/OVERDUB footswitch will just restart the Single phrase playback from the beginning.
Time Signature

The JamMan® is capable of recording in different Time Signatures. A Time Signature must be set up prior to recording in a memory location. Once a phrase has been recorded, Time Signature cannot be changed. To set the Time Signature, follow these steps:

1. Select a new memory location. (The LOOP LED and SINGLE LED will be off.)
2. Press the SHIFT button. It will now be lit.
3. Press the TIME SIGNATURE button. The DISPLAY will now show the number 4 indicating the default Time Signature of four beats per measure.
4. Use the SELECT knob to change the Time Signature. You can select from two to 15 beats per measure. This means if you want to record in 5/4 time, select 5. To record in 7/8 time, select 7, and so forth.

The STORE button will light when Time Signature is changed but you can immediately begin recording without having to store this change first. The TIME SIGNATURE LED will light red for the downbeat and then green for the rest of the beats of the measure if a tempo has been set up.

When you press the TIME SIGNATURE button while a recorded loop is selected, the loop’s Time Signature appears in the DISPLAY, but it cannot be changed.
The JamMan® has several Rhythm Type guide tracks you can select from. These range from a simple click metronome to using high quality drum samples as the rhythm guide (a tempo must be set and the rhythm level must be turned up to hear the rhythm). To change the Rhythm Type, follow these steps:

1. Select a memory location.
2. If the memory location is empty (LOOP and SINGLE LEDs are off), set a tempo (see page 23). If the memory location contains a loop (LOOP or SINGLE LED is on), press the REC/PLAY/OVERDUB footswitch to start playback.
3. Press the button. It will now be lit.
4. Press the button. The DISPLAY will now show r1 indicating the default Rhythm Type which is a standard metronome. Turn up the Rhythm Level if you don’t hear the metronome.
5. Rotate the SELECT knob to choose your desired rhythm sound (designated off, and r1 – r9 in the display). Selecting off turns the rhythm sound off even if the rhythm level is up.
6. If the memory location is empty, press the REC/PLAY/OVERDUB footswitch to begin recording. If the memory location contains a loop, press the STOP/TEMPO footswitch to stop playback, then press the STORE button twice to save the new Rhythm Type.

**Rhythm Types**

- off – Off
- r1 – Wood Blocks
- r2 – Sticks
- r3 – Click
- r4 – Alternative Kick / High Hat
- r5 – Studio Kick / High Hat
- r6 – Techno Kick / High Hat
- r7 – Cowbell
- r8 – Conga
- r9 – Tambourine
The JamMan® features a USB port which is used for file transfer of loops to and from your computer. We recommend only connecting the JamMan to computers using Windows® XP and Mac® OS X operating systems. Once the JamMan is connected to your computer with a CompactFlash® card inserted, it will appear as a removable hard drive in your system. The card that is shipped with the JamMan will appear as a drive named “JAMMAN”. Using other cards will not necessarily have the same name.

When you double-click on this new drive, a JAMMAN directory/folder will be present. Inside the JAMMAN directory are all the loop phrase subdirectories named LOOP01 through LOOP99, depending on which memory locations have recorded phrases. Only loop memory locations that have recorded phrases will have directories available. Each LOOPXX directory contains two files, a LOOP.WAV file which is the actual recorded data and a LOOP.XML which contains setup information. It is important that these are never separated as the .XML file has important information about how the JamMan handles the LOOP.WAV file and what attributes are saved with it. You can freely exchange the LOOPXX directories back and forth between the JamMan and the computer just as you would other files. Just be sure to move the whole LOOPXX directory and not the individual files inside.

Exchange Files Between Your Computer and the JamMan®

Windows XP

1. Stop any playback/recording/overdubbing on the JamMan.
2. Connect a USB cable from your computer to the USB jack on the JamMan’s rear panel. The JamMan DISPLAY will read "CF", indicating it is now being used as a CompactFlash card reader.
3. Double-click the My Computer icon on your computer’s desktop. There should be a new removable drive named JAMMAN.
4. Double-click the JAMMAN drive. You will now see all the loop
directories that have been recorded.
5. To move them from the card to your computer, either drag them to your computer’s desktop or select the directories you wish to move and select **Edit>Copy** in the task bar.
6. Open a different directory on your computer and select **Edit>Paste**. The loop directories copied will now be pasted in this location.
7. Right-click the JAMMAN drive and select Eject before removing the CompactFlash® card or unplugging the USB cable.

Moving loop directories from your computer is done in the same manner. Select the loop directory on the computer and move it into the JAMMAN directory by dragging or using the Copy/Paste commands.

**Mac OS X**
1. Stop any playback/recording/overdubbing on the JamMan®.
2. Connect a USB cable from your computer to the **USB** jack on the JamMan’s rear panel. The JamMan **DISPLAY** will read **CF**, indicating it is now being used as a CompactFlash® card reader.
3. A new removable drive will appear on your computer’s desktop named JAMMAN.
4. Double-click the JAMMAN drive. You will now see all the loop folders that have been recorded.
5. To move them from the card to your computer, either drag them to your computer’s desktop or select the folder(s) you wish to move and select **File>Edit>Copy** in the task bar.
6. Open a different folder on your computer and select **File>Edit>Paste**. The loop folders copied will now be pasted in this location.
7. Eject the JAMMAN drive before removing the CompactFlash card or unplugging the USB cable.

Moving loop folders from your computer is done in the same manner. Select the loop folder on the computer and move it into the JAMMAN directory by dragging or using the Copy/Paste commands.
Deleting Phrases

The JamMan® has 99 memory locations and at some time you may need to delete the contents of a memory location so it may be reused. To delete a loop from a memory location, follow these steps:

1. Press the **SHIFT** button. It will now be lit.
2. Press the **DELETE** button. This button will now flash waiting for a delete confirmation. (Press **EXIT** at this point to abort the Delete procedure.)
3. If you want to delete all contents from this memory location and return it to its default state, press and hold the **DELETE** button for two seconds. The **DISPLAY** will then read **dE** indicating the delete procedure is complete.

**WARNING:** Deleting a memory location is irreversible and will erase any recorded information that resides here. Use the Delete function with caution.
Erasing All Loops / Formatting the CompactFlash® Card

The JamMan® has two types of card erase procedures: Erase Loops and Format Card. The Erase Loops procedure only erases JamMan loop data. All other data and files on the card are left untouched. The Format Card procedure erases all data and files on the CompactFlash® card. To use either of these two procedures follow these steps:

**Erase Loops**
1. Press and hold the **SHIFT**, **STORE** and **DELETE** buttons simultaneously for two seconds. The display will show **EL** (Erase Loops) and the **DELETE** button will flash.
2. Press the **DELETE** button. The display reads **E ?** (Erase Loops?) and the **DELETE** button continues to flash. To abort this procedure, press the **EXIT** button.
3. To erase all loop data, press and hold the **DELETE** button for two seconds. The **CARD BUSY** LED beside the **DISPLAY** will light indicating the card is erasing data.

**Format a CompactFlash Card**
1. Press and hold the **SHIFT**, **STORE** and **DELETE** buttons simultaneously for two seconds. The display will show **EL** (Erase Loops) and the **DELETE** button will flash.
2. Rotate the **SELECT** knob and **FO** (Format) will appear in the **DISPLAY**.
3. Press the **DELETE** button. **F ?** (Format ?) will now appear in the **DISPLAY** (the **DELETE** button will continue to flash). To abort this procedure, press the **EXIT** button.
4. To initiate the card formatting procedure, press and hold the **DELETE** button for two seconds. The **CARD BUSY** LED beside the **DISPLAY** will light indicating the card is being formatted.

**NOTE:** When using a different CompactFlash card than the one that came with the JamMan, it is recommended that you format it using the procedure outlined above before using it with the JamMan.
Erasing All Loops / Formatting the CompactFlash® Card

Unformatted Cards
If a card is inserted into the JamMan that does not have a valid format, the JamMan® will not recognize it and the DISPLAY will read nF. The card must be formatted before the JamMan can use it. To format the card, follow these steps:

1. While the DISPLAY reads nF, the DELETE button will begin flashing prompting for a format confirmation.
2. Press the flashing DELETE button. The DISPLAY will read F? and the DELETE button will continue to flash. You can press the EXIT button to abort the procedure.
3. To initiate the card formatting procedure, press and hold the DELETE button for two seconds. The CARD BUSY LED beside the DISPLAY will light indicating the card is being formatted.

Once completed, the DISPLAY will show 1, the INST/MIC LED will light next to the RECORD MODE button, and the card is now ready for recording.

WARNING: Using these procedures will permanently erase data from the CompactFlash® card. Use them with extreme caution.

NOTE: When the JamMan is shipped from the factory, the CompactFlash card is held in place with a security bracket. To remove the security bracket, unscrew and remove the FOOTSWITCH input nut with a 12mm nut driver. After removing the security bracket, replace the nut on the FOOTSWITCH input.
Optional FS3X Footswitch

The optional FS3X Footswitch gives you hands-free control over loop selection and Auto Record functions.

Mode Switch
Turns the Auto Record feature on and off.

Down Switch
Selects the next lower memory location. Press and hold for two seconds to scroll through the memory locations more quickly.

Up Switch
Selects the next higher memory location. Press and hold for two seconds to scroll through the memory locations more quickly.
Multiple Loop Playback Using the FS3X

Another great feature of the JamMan® is its ability to play different loops back to back during performance using the optional FS3X Footswitch. This lets you play a verse > chorus > verse > bridge progression seamlessly using three different loops.

To set up multiple loops for verse/chorus/verse/bridge playback, follow these steps:

1. Record the verse loop and store it to memory location 1.
2. Record the chorus loop and store it to memory location 2.
3. Record the bridge loop and store it to memory location 3.

To use these three loops in a performance, follow these steps:

1. Select Loop 1 (verse loop) and press the REC/PLAY/OVERDUB footswitch. Loop 1 will begin playing back.
2. To switch to Loop 2 (chorus loop), press the UP footswitch on the FS3X at least two seconds before the end of Loop 1. Once Loop 2 is selected, the DISPLAY will show a flashing 2, indicating Loop 2 is cued up to play once Loop 1 finishes. Once Loop 2 begins playing, the DISPLAY will stop flashing.
3. To select Loop 1 again, press the DOWN footswitch on the FS3X.
4. After Loop 1 begins playing again, you can then select Loop 3 (bridge loop) by pressing the UP footswitch twice. The DISPLAY will show a flashing 3.

Memory locations 1, 2, and 3 are used for this example, but any memory locations can be used for multiple loop playback. (See page 22 for more information about storing loops.)

Pressing either the UP or DOWN footswitch on the FS3X less than two seconds before the end of a loop that is playing will not give the JamMan enough time to cue up the next loop and the current loop will play one more time. If any overdubs were recorded during this type of performance, they will be lost when the next loop is selected and begins playing back. You can also use the SELECT knob to change loops during playback.
The JamMan® supports Type I CompactFlash® cards up to 2GB. The following table shows approximate storage capacity in minutes for standard CompactFlash card sizes, based on 44.1 KHz 16 bit mono audio files.

<table>
<thead>
<tr>
<th>Memory Size in MB</th>
<th>Record Time in Minutes*</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>1.5</td>
</tr>
<tr>
<td>16</td>
<td>3</td>
</tr>
<tr>
<td>32</td>
<td>6</td>
</tr>
<tr>
<td>64</td>
<td>12</td>
</tr>
<tr>
<td>128</td>
<td>24</td>
</tr>
<tr>
<td>256</td>
<td>48</td>
</tr>
<tr>
<td>512</td>
<td>96</td>
</tr>
<tr>
<td>1024</td>
<td>193</td>
</tr>
<tr>
<td>2048</td>
<td>387</td>
</tr>
</tbody>
</table>

When the CompactFlash card becomes full, the JamMan’s DISPLAY will briefly show df, and the current recording (or overdub) will be lost. To free up some memory on a full card, you can either delete some phrases (page 32) or erase all the phrases on the card (page 33).

**NOTE:** When the JamMan is shipped from the factory, the CompactFlash card is held in place with a security bracket. To remove the security bracket, unscrew and remove the FOOTSWITCH input nut with a 12mm nut driver. After removing the security bracket, replace the nut on the FOOTSWITCH input.
Specifications

*Approximate values

**Digital**

A/D/A Converters: 24-bit audio
Sampling Frequency: 44.1 kHz

**USB**

Type: USB 1.1 Full Speed, supports USB 2.0
Protocol: Mass Storage
Connector: Type B

**Memory**

CompactFlash®: Type I solid state only (Type II cards or IBM/Hitachi Microdrives™ not supported)
Size: 8 MB to 2 GB
Capacity: 1 minute per 5.29 MB, 99 loops per card
File Format: FAT16 only
Audio Format: Uncompressed .wav 44.1 kHz 16 bit mono

**Inputs/Outputs**

Instrument/Guitar Input: 1/4” Unbalanced (Tip-Sleeve)
Input Impedance: 1 MΩms
Maximum Input Level: 11 dBu

Microphone Input: XLR Balanced (Female XLR, pin 2 Hot), not powered
Input Impedance: 600 Ohms balanced
Maximum Input Level: -7.5 dBu

Auxiliary Input: 1/8” Stereo (Tip-Ring-Sleeve), sums to mono
Input Impedance: 20 kΩms
Maximum Input Level: 0 dBu
## Specifications

**Footswitch:**
- 1/4” jack (Tip-Ring-Sleeve)
- compatible with optional FS3X

**Line/Headphone Output:**
- 1/4” Mono (Tip-Ring-Sleeve)
- Stereo headphone compatible with 50 Ohms minimum impedance, driven by mono signal

**Output Impedance:** 100 Ohms

**Maximum Output Level:** 10 dBu

### Power

<table>
<thead>
<tr>
<th>Region</th>
<th>Voltage</th>
<th>Frequency</th>
<th>Adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>US and Canada</td>
<td>120 VAC</td>
<td>60 Hz</td>
<td>PS0913B - 120</td>
</tr>
<tr>
<td>Japan</td>
<td>100 VAC</td>
<td>50/60 Hz</td>
<td>PS0913B - 100</td>
</tr>
<tr>
<td>Europe</td>
<td>230 VAC</td>
<td>50 Hz</td>
<td>PS0913B - 230</td>
</tr>
<tr>
<td>UK</td>
<td>240 VAC</td>
<td>50 Hz</td>
<td>PS0913B - 240</td>
</tr>
</tbody>
</table>

**Power Input:** 9 VAC 1.3 A

**Power Consumption:** 7 Watts

### General

**Dimensions:**
- 6.7” Width x 5.6” Length x 2.6” Height

**Weight:** 2.88 lbs

DigiTech® engineers are constantly working to improve the quality of our products. Specifications are therefore subject to change without notice.